Applies to

SAP NetWeaver Composition Environment 7.1 EhP1. You will need the runtime (CE 7.10 Application
Server Java) and the design time (the Eclipse-based SAP NetWeaver Developer Studio) in this document
often abbreviated with the “IDE”.

Petstore — the AJAX-enabled Java EE 5 Reference Application as provided by Sun. The version used here
is Petstore 2.0.

GlassFish — Sun’s Java Application Server, which is the reference implementation of the Java EE 5 runtime
specification. The version used here is GlassFish V2.1. This document will most likely also apply for the
GlassFish version 3.0.

Note: The migration described in this document has also been tested with and applies to NetWeaver Composition
Environment 7.20.

Summary

This document is a detailed step-by-step guide on migration of Petstore 2.0 to SAP NetWeaver Composition
Environment. There is a paper published on SDN discussing general issues of migrating Java Enterprise
Applications to SAP NetWeaver Java.
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Introduction

The SAP NetWeaver Composition Environment is an SAP product suitable for design, assembly, deployment and
productive operation of complex and enterprise ready composite applications. The core of this product is a Java EE 5
compliant and certified application server, even though this server does not appear on SAP’s price list as a stand-alone
product.

Note: In this guide we will often refer to this application server as the “SAP Java Engine”.

Note: SAP NetWeaver Composition Environment is a highly configurable platform. It introduces a concept of the so-
called “Zero-Admin-Templates”. A Zero-Admin-Template is a preconfigured profile meeting the requirements for a
dedicated usage of the platform. For example, one can use the Composition Environment for

o development of plain Java EE applications,
e as a development platform for business processes
e oreven as a runtime platform for scalable and highly available composite applications in productive usage.

All these usage types require different configurations of the platform, e.g. the OS specific executables. For example, the
heap size configuration of the Java Virtual Machine is somewhat different for a system used in development or in
production.

The Zero-Admin-Template concept also allows for extensions, so you can define your own templates and thus your own
usage type of the platform. One can switch among the various usage types by simply activating the corresponding
template e.g. profile on the platform already installed, since the preconfigured templates all come with the same binary
set of the product shipment.

A template called “javaee_development” is the most simple usage type. It allows for development and deployment of
“standard” Java EE applications. This usage type defines a runtime server comparable to GlassFish.

Note: This guide describes the migration of the Petstore 2.0 Java EE 5 reference application to the SAP Java Engine —
the Java EE 5 compliant and certified application server.

The major steps performed here are
e Downloading and installing GlassFish
e Downloading and installing SAP NetWeaver Composition Environment 7.1 EhP1.
e Downloading and installing/deploying Petstore 2.0 to GlassFish.
e Running Pestore and checking the functionalities of the application
e Initial migration of the Petstore application to the SAP Java Engine
e Minor adjustment of the application’s source code to fully run on SAP Java Engine.

Note: The steps are performed on a developer’s desktop machine with JDK 1.5. You will not need more then 3 GB of
RAM. The memory footprint on the local hard drive depends on the requirements of the software installed but should not
exceed the total of 12 GB. The major part of this footprint goes to the system database of the SAP Java Engine (over 7
GB), which is built in the architecture of the platform and thus not surprising.

Note: You will be able to run both — GlassFish as well as the SAP Java Engine along with SAP’s Developer Studio — on
the very same machine at the same time. There is no remote installation or runtime access required. This way you will be
able to easily check and compare the functionality of the Petstore application running on both platforms — GlassFish and
SAP Java Engine.
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Setting up the Environment

This guide assumes that the Petstore 2.0 reference application runs on Glassfish v2 with an embedded Derby database
as Petstore’s data persistence storage. For more details on installing Glassfish and deploying Petstore please refer to the
corresponding documentation. You can start by downloading the Petstore 2.0 reference application from Sun Developer

Network.

Please note that some of the Sun specific links referred to in this document may change over time.

Step 1 — Download and Install GlassFish

In this case we downloaded GlassFish from
http://java.sun.com. Under the area “Popular
Downloads” you have the Link “Java EE 5 SDK”. We have
selected the package “GlassFish Java EE + JDK” for
Windows environments as indicated in the screenshot to
the right hand side (last column).

Platform

Choose a Language I English 'l

Windowes j

Components GlassFish + MyS0OL G:a:us:é:h J:;J:SE:FISJEI{
Licenses Wiy Licenze Wi License Wigw Licenze
GlassFish* . = U
MySQL b
Samples . L]
BluePrints . b
Tutorial . .

L ] L]

Documentation
Java SE (JDK)*
Open ESB

Access Manager
Portlet Container*
WS5RP*

Portal Pack®

HetBeans IDE*

Free, 140MB

Download

Free, 100KB

Download

Free, 170MB

Note: In this case the GlassFish installation directory is
C:\Sun\SDK. Note that this is the property you have to
maintain in Petstore’s build.properties in order to
successfully build and deploy Petstore to Glassfish. This
property is also needed for deployment of the tables in the
embedded Derby database — so make sure you maintain it
correctly.

SAP COMMUNITY NETWORK

Select Installation Directory

Installation Directary;
CASUNSDK

| Browse... |
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Note: The admin password is set in this step. This will
generate an admin-password file, which corresponds to
the default settings of Petstore’s build script — if you have
chosen the GlassFish installation directory as described in
the previous step.

Here is a summary of the components to be installed.

Step 2 — Download Petstore

DOWnload Petstore 2.0. Start at Download the Java Pet Store
http://java.sun.com/developer/releases/petstore/ ...

The Java Petstore 2.0 Early Access runs on the Java EE 5 SDIK.
FPetstore Demo 1.3.2 are also available.

+ Download

SAP COMMUNITY NETWORK SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
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... And navigate to the early access download area. petstore

Java Pat Store Reference Annlication, Version 2.0 Eatly Access

Filter this list I Filter |

Name Status Modified by Size  Resenvations
2| javapetstore-2.0- Draft basler on Thursday,  7.46
2ag-installer.jar Bugust 9, 2007 at me
10:28:10 P
Step 3 — Install Petstore
Install Petstore by unpacking the archive Marne = | Size | Type
javapetstore-2.0-ea5-installer.jar ata [Shjavapetstore-2.0-ea5 File Falder
destination of your choice. |§] javapetstore-2,0-ea5-installer . jar 7.639KE Executable Jar File
Step 4 — Build and Deploy Petstore on GlassFish
Open the index.html in the Petstore distribution and Mame = I Size | Type
follow the instructions to set up Petstore (build and (Dbp-project File: Folder
dep|oy) Ellh File Folder
. o . nbproject File Folder
Note: it is recommended that you maintain the admin Ddnberof .
N oI - . [setup File Folder
password file in your GlassFish instance as described in ,
the instruction. Dsre File Falder
) [C)web File Folder
Note: Make sure you have started Glassflgh and the _ [Z] 3RD-PARTY-LICENSE txt S5 KE  Text Document
Derby database before you run the ant scripts for setting = .
. = bp-project. xmi 1KE %ML Document
up Petstore (build and deploy). =
Z build =il 4 KB XML Document
&]index.htrl 14KE  HTML Document

Step 5 — Install SAP NetWeaver Composition Environment

Obtain the SAP NetWeaver Composition Environment 7.1 EhP1, e.g. by downloading a trial version from SDN
(http://www.sdn.sap.com/irj/scn/nw-ce-downloads ).

You would have to install the runtime server (SAP NetWeaver CE Java) and the design time (SAP NetWeaver Developer
Studio).

Note: A detailed installation guide is included in the download package as a PDF document.

Initial Migration of the Petstore Application

This guide primarily describes the migration of the Petstore application. The Petstore application uses a persistence data
store — the embedded Derby database that came with the GlassFish installation. Here is what you need to do in order to
deploy the Derby JDBC driver to SAP NetWeaver.

Step 1 — Deploy a Derby JDBC Driver to NetWeaver
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Login to the NetWeaver Administrator

You need to be an administrator to be able to perform
the actions described in this section. The default
administrator user ID is “administrator” (case-
insensitive). You have specified the password for this
user during the installation of NetWeaver.

Userip®  acministrator

Password* eesssses

Log On

Copytight ®

6. All Rights Reserved

Navigate to “Application Resources”

Tab Configuration Management - Infrastructure. This
is the area where you can maintain your resource, as
for example your custom DB data sources (instances
of javax.sqgl.DataSource) and related JDBC
drivers. This is the place where you manage other
application resources, e.g. JCA and JMS resources as
well as your own resource adapters.

SAP NetWeaver Administrator
User: Administrator | Active Profile: Complete List, | System: LKG on wdlfn00234162a, v.7.20
My Workspace |

Avsilahilty and Performance Menagement © Operation it <

Security | Infrastructure | Scenarios | Connectivity

[FE55] 4abe Docunent Services
[ 05]  Contfours i manags the Acche documert servicss (credsrtiss, tusted snchors, certifosts revocation Ists,
5 license information, caches, and job profies)

—"| Applicstion Resources

7 The Application Resources plug-in provides functionaity to create, manage, and delete external resources such as
JDBC tifivers, JDBC dala SOUCSS, resoUrce adapters, Connection Tactories, and others. The sdministrator can visw
all resources or choose & specific resource type and select a resource from the resources list. He or she can view
its dlstalls andl the details of all antecedsnt and dependent resources

il

5%, (P

-

f

Deploy New JDBC Driver

Deploy a Derby JDBC driver to NetWeaver. This
means that you have to

e Give this driver a logical name and
e Upload a the Derby specific JAR file

See the next two steps for details.

SAP COMMUNITY NETWORK

Application Resotnrces: Overview

Showe: |AII Resources v|

Resource List

| Create hew Resource a || Delete Selected Resource | | Refresh
Deploy Meswy JOBC Driver

Mewy JOBC Custom DataSource

Mewy JDBC DataSource Alias

Mesn JMS Connection Factory Reference

Mewy WS Destination Reference

Mewy JME Saf Agent Reference

Mewy Resource Adapter

nnectionFactory
[« ClassificationServiceY20ueus
DAzerviceQueUs

DaservicetueusFactory

JobiCueue

JobGueusFactory
NZDMClusterMotificationTopic

[y wily wRN o 4g -]

[T T LTI

Possible States: Fully arvailable O Partly availakle @ ot svailable <2 Unknown
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Set a Logical Name for the Driver Application Resources: Overview

We named the driver as “Derby”.

New JDBC Driver Creation

< Setings

JDBC Driver Name: * [Derby |

| Add Mewy Driver File || Remove Selected Driver File |

BE. File Mame
[3] Mo files to display

. . Mame =~ | Size | Tvpe |
Add New Driver File @derby.jar 2,391 KB Executable Jar File
The correct driver is called derbyclient.jar and B derby.war ZKE  WInRAR archive
can be found under C:\Sun\SDK\javadb\1lib of B derbyclient jar SOZKE  Executable Jar File
your GlassFish installation directory. ﬁ derbyLocale_de_DE.jar 96 KB Executable Jar File
g derbylLocale_es.jar 91 KB Executable Jar File
Q derbylLocale_fr.jar 97 KB Executable Jar File
ﬁ derbyLocale_it,jar I0KE Executable Jar File
Q derbylocale_ja_IP.jar 111 KE Executable Jar File
ﬁ derbyLocale_ko_kR. jar 104 KE Executable Jar File
Q derbylLocale_pt_ER.jar 86 KB Executable Jar File
ﬁ derbyLocale_zh_CM.jar 95 KB Executable Jar File
Q derbylocale_zh_Tw.jar 97 KB Executable Jar File
ﬁ derbynet.jar 225 KB Executable Jar File
Q derbyrun.jar 6 KE Executable Jar File
ﬁ derbytools, jar 153 KE Executable Jar File

Step 2 — Deploy the Petstore JDBC Data Source

Now you have to deploy a JDBC Data Source used by the Petstore application. These are the steps to do so and the
necessary settings:

SAP COMMUNITY NETWORK SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
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Create a Custom JDBC Data Source Application Resources: Overview

Navigate to Application Services and select “New JDBC
Custom DataSource”.

Show: |AII Resources A |

Resource List

[ Create Mew Resource || Delete Selected Resource | [ Refresh
Deploy Mew JOBC Driver
Mewy JOBC Custom DetaSource
Mewy JOBC DataSource Alias
Mewy JMS Connection Factory Reference
Mewy JMS Destinstion Reference
Mewy JM= Saf Agert Reference

Mewy Resource Adapter snnectionFactory

ClazsificationService\ 2Eueue
DAzerviceueue
DaAservicetueueF actory
Derby

JohGueus

(SRR RR SR~y SR 1

JohGueueFactory

Possible States: ([@ Fully available & Partly available @ Wot Available < Unknawn

Custom Data Source Settings Application Resources: Overview

Here are the settings and some detailed explanations
on their meaning. Some of them are standard Java
JDBC API attributes.

New JDBC Custom DataSource Creation

“Application Name”: Every data source is being
deployed and thus managed as an application. ThIS iS 1 Settings ‘ Connection Pooling Additional Propetties JDBC DataSource Alisses

the name of this application. This is NOT the JNDI name
of the data source. You can set it to “PetstoreDB’.
This is only a SAP-relevant name, so you can freely

Application Mame:  [PetstoreDB
DataSource Mame: * |jdbc.iP315‘IUrEDEl |

. Driver Name: * |Derby -]
choose it. SAL Engine: * [endar saL ~]
“DataSource Name”: This is the JNDI name of the data lsolation Level: *  [Defaut hd
source — as you would find it in the web . xm1 or LGt oo (il A support) ~]

Driver Claz=s Name: * |nrg apache derby jdbc ClertDriver

persistence.xml of the application. It is highly
recommended to keep the name as defined in the
Petstore application: “jdbc/PetstoreDB”.

Database URL: * |ictoc:derby:mocalhost: 1 527 ipetstore;create=false

Lizer Name: * APF

Password: e ]

“Isolation Level”: This is a support level of SAP’s Description:
database abstraction. For more details on the concept
consult online documentation http://help.sap.com. Set
this level to “Vendor SQL”.

“Driver name”: Here you can select the “Derby” driver
you have previously deployed.

“Driver Class Name”: in this case
org.apache.derby. jdbc.ClientDriver

“JDBC URL”: JDBC URL of the petstore database:
jdbc:derby://<host_name>:1527/petstore

“User ID”: APP

“Password”: APP

SAP COMMUNITY NETWORK SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
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Initial Connections of the Data Source Application Resources: Overview

It is recommended that you set the initial connections for
this data source to something different than “0”. This is
so to speak a design time check for the correctness of

your configuration. This will prevent you from getting a Hesd TRy atasauiceleieation

runtime exception in the application caused by

Connection refusal, Settings ¢ Connection Pooling Additional Properties JDBEC DataSource Aliases
For migration purposes it is sufficient to set this value to Initial Connections: * | 1

“1”. You will find these settings under the sub tab Mximum Connections: | 25
“Connection Pooling” of the data source. iaximum Time to Wit for Connection: * | 120

] Expirstion
Save the settings by pressing the “Save” button.

Successfully Configured Custom Data Source Application Resources: Overview

Now you can see the operational data source.

Show: |JDEIC Custom DataSources v|

Resource List

[ Creste New Resource « || Delete Selected Resource | | Refresh

B State Reszource Mame
jdbc/PetstoreDB

Step 3 — Maintain the SAP Server in the IDE

In order to deploy the migrated application more efficiently, we suggest that you maintain the server instance in the SAP
NetWeaver Developer Studio (IDE). This will allow for deployment of the application straight from the IDE.
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Open the IDE

Open the IDE and go to Window > Preferences. Select
“SAP AS Java” from the list of resources and add a
default system. “Default system” means that this will be
the system that the IDE will be deploying to by default.

Note: in a migration scenario you usually have only one
system — the default one.

Itypa filker bext

SAP AS Java e '

=10lx]

(- Composite Designer d
[#]- Data Management
Deployment

|- Destination Configurations
- Development Infrastructure
- Dictionary

+- Help

- Install/Update

- Java

|- Javascript

H- I

+- Mobile:

- Model Validation

- Madeling Infrastructure

- Plug-in Development

H- Process Composer

+|- RunDebug

rstem for deployment.

afNumnber

| Defaulk Syskem

| add... |
Delete |

[ [ e e [ - - - - -]

[#1- SAP JZEE
- SAP Management Console

Bl Server rstem must be set.

- Service Compositian 57
< | _’lJ r

P Systems ko be used for monitoring, contral, deployment and debugging.

o ol |

. =2 add new SAP System x|

Add a default server instance Specify a hostname and an instance number of an instance
Press the “Add” button and specify the settings for the which belongs to the system that should be added:
instance host, the instance number and the domain as Instance Hostname: | lacalhast
indicated in the screen shot on the right hand side.

Instance Murnber; | o1

Add to Domain: I Default j

Use HTTPS: r

oK I Cancel |
- - B g
Result — the SAP system is recognized =iol A
SAP AS Java - -

The IDE automatically recognized the SID and the DNS
mapping of the SAP server running on the specific host
— as defined maintained in the previous step.

SAP COMMUNITY NETWORK

Add or remove SAP Syskems to be used for monitoring, contral, deployment and debugging.
Select a default system For deployment,

Default System Add...

Delete |

Systemn Instance/Murnber

WOFNOO0Z341624/0
WOFNIOZ341624[1
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Add the server view to the IDE

Go to Window - Open View - Other - Server >
Servers and press “OK”.

[%5 Show Yiew N =] |

It';.-'pe Filker text

-2 SAF A5 Java -
-5 Component Properties

@ Daka Collector Results
----- i InFo Yiew

= =] Log File Wiew

o g Management Console

F-[= search Consale

== Team

== Yalidation

~[= Visual Composer
~[== Weh Dynpro
-2 Weh Services
= Cther

-

Ilse F2 to display the description For a selected view.

Ik I Cancel

Result — the default server instance view

This opens the server view (Eclipse view) of your default
server instance. In this particular case one observes
that the default server instance is already started.

Step 4 — Create the IDE Projects Structure

[£i Prablems (@ Jawadac (@ Declaration (45?& Servers &3

Server =~ State

5] sar s G . Started

This will enable you to assemble the deployable archives and the code changes. Open the IDE if not already opened and

switch to the Java EE perspective.

SAP COMMUNITY NETWORK
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

Create an empty Dynamic Web Project

Go to File > New - Dynamic Web Project. Make sure
the web module’s version is 2.5. In this case we are not
saving the project in the default workspace but rather
under C:\dev\petstore. Changing the (Eclipse IDE)
proposed default value has no implication on the
migration.

Click on “Next” to go to the next step.

[52 New Dynamic Web Project =]
Dynamic Web Project 5
Create a standalone Dynamic Web project or add it to a new or existing Enterprise Application. | @

Project name: | pebstore

i~ Contents
I~ use default

Browse...
d New...

"Dynamic ‘web Module version ‘

Directory: IC:'tdev'tDatstUrd

i~ Target Runtime

[SaF Libraries

s =

— Configuration

j Madify...

A good skarking point For working with SAP Libraries runtime. Additional facets can later be installed to

IDeFauIt Configuration For SAP Libraries

[ EAR Membership
[~ Add project ko an EAR

E&R Project Mame: | EAR

j ew.. .

Create the structure of the web project

In this step you will create the structure of the web
project as it will be managed by the IDE.

Important: Here you also set the context root of the
migrated application. Set it to “petstore” as this is the
context root of the original application. Press “Finish” to
conclude the creation of the Eclipse project.

7 = Back Next > | Finish I Cancel
= New Dynamic Web Project _I- _ID ﬁl

Web Module o @
Configure web module settings. i 7

Context Root;

| petstors
Conkent Direckory:

| ‘WebContent

Java Source Directory:

I B

¥ Generate deployment descriptor

Adjust Build Path of the Web Project Sources

In the preferences of the Dynamic Web Project (context
menu of the web project “pestore”) go to “Java Build
Path” and set the default output folder for the binaries
to petstore/WebContent /WEB-INF/classes
rather than the default value WEB-INF/classes.

This way the subsequent source code changes will
be directly maintained in the Web Project archive
(the WAR file).

SAP COMMUNITY NETWORK

%2 Properties for petstore =laix|
v filter text Java Build Path o
Resource
- BeanInfa Fath 2 Source |B Projects | =i Libraries | % Order and Export |
Buiders

Source folders on build path:

~Java Build Path
Java Code Style

- Java Campiler
Java Editor

(# petstorefsrc

Add Falder...

Link Source...
- Javadoc Location

Edit...
- Javascript Remove
- JLin

ISP Fragment
- Project Facets
Project References
- Project Walidation
RunjDebug Settings
- Server
Service Policies
- Targeted Runtimes
Task Repository
~Task Tags
Walidation
- web Content Settings
web Project Settings

- Java EE Module Dependencies

™ Allow output Folders For source Folders

Default output Folder:

| petstorefWebContentWEB-INF/dasses

Erowse. ..

[+ ¥Daclet
q v 2l [ 2]
@ e |
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

Create an empty Enterprise Project
Go to File > New > Enterprise Application Project.

Again, as in case of the web project, we are storing the
content of the project under C:\dev\petstoreEAR
and not under the path proposed by Eclipse (the IDE).

'—:-: New EAR Application Project ;IEIEI

EAR Application Project
Create a EAR application,

Projeck name: | petstoreEAR

[~ Contents
[~ Use default

Brawse. .. |
j MNew, .. |
[ EAR wersion
Js.0 |
r— Configuration
j Modify. .. |

A good starting point For working with SAP Libraries runtime. Additional facets can later be

Directory: |C:'|,dev'|,petstoreEAR

i~ Target Runtime

| 58P Libraries

IDeFauIt Configuration For SAP Libr aries

@ = Back Next = Finish | Cancel I

Include the Web Project in the Build Configuration

This will create a build dependency to the Web Project.
This means that every time the Enterprise Archive
(EAR) is built, the Web Archive is built prior to that
action.

[52 New EAR Application Project ol x|

Enterprise Application

Configure enterprise application settings.

Java EE Module Dependencies:

petstaore

Select Al I Deselect Al I Tew Module,..

Conkent Directory:

I EarContent

¥ Generate Deployment Descripkor

@) < Back et = | Finish I

Cancel

Step 5 — Import Petstore’s Source and Binaries into the IDE

During regular development you usually create (web) artifacts by using the IDE wizards. Since we are dealing with a
migration here, the development artifacts are already created. They just have to be imported in the IDE. We do so by
performing copy-and-paste actions on file system level and subsequently refreshing the project content in the IDE.

Note: The Petstore’s original web project root is C: \javapetstore-2.0-ea5\build\web.Every operation performed

and described in the following section refers to it.

SAP COMMUNITY NETWORK
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

Import Petstore’s web resources into your web
project

Copy the web content C: \javapetstore-2.0-
ea5\build\web (all but the WEB-INF folder) to
C:\dev\petstore\WebContent.

Do not copy the WEB-INF folder now. There are
adjustments to be done here, which are described in
the next steps.

Note: as you may notice, we copy the Java sources
in the web project. The Java sources also contain the
business logic as well as the persistence classes
(entity objects). Petstore does not work with Entity
EJBs but simple JPA persistence units.

Mame =~

Sizel Type

| Date Modified

() WEEB-IMF

ZKE
10KE
4 kB
1KE
12 kB
6 kB
SKE
1KE
15 KE
6 kB
6 kB
3KE
1KE
ZKE
1KE
1KE
11 KE
15 KE

File Folder
File Folder

Cascading Style Sh...

J5cript Script File
J5P File

Cascading Style Sh...

J5cript Script File
J5cript Script File
J5cript Script File
J5P File

J5cript Script File
J5P File

J5P-0LD File
J5cripk Script File
J5P File

J5cript Script File
JSOM File

Text Docurment
J5cript Script File
J5P File

31.07.2009 16:25
31.07.2009 16:25
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24.09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45
24,09.2009 10:45

o Mame = Size |

Copy the dependent libraries T 1514 KB
Copy the jars from C:\javapetstore-2.0- 3Z2KB
eab5\build\web\WEB-INF\1lib to 5 KE
C:\Jjavapetstore-2.0-ea5\build\web\WEB- =5 KB
INF\1lib (all but the petstoreIndexes.zip). : :

jdam. jar 150 KB
Note: The petstoreIndexes.zip is a file based ||J.:Er,,3_.:.:.r-,3_;:_-.|:|.|:|.]',5,r- 395 KR
database search index. Petst_ore uses Ap_ache s gpetstnrelndexes.zip 36 KR
Lucene to create a denormalized search index of the 31 P 193 KB
database content and the search in the application is FOME-HLE. 151
performed against this index and not against the £ rome-Fetcher-0.7. jar 22 KB
database. Unfortunately this index is deployed and 3] shale-rermating. jar KB
maintained by Petstore in a very rigid and inflexible
way.

ice . Marne = Size I Type
Copy the JPA specific persistence.xml .
[Cclasses File: Falder
Putthe C:\javapetstore-2.0- Slib File: Folder
ea5\build\web\WEB-INF\persistence.xml | Faces-config.xml 4KE ML Document
uncti)er C: \devh\.pgtshtore\f.src\I.VIETS—iNF of the h : {KE %ML Document
we pr.OJect. This s the con |gur§1t|on e Or.‘]PA.' . = sun-web. xml 1 KB XML Document
This will allow for assembling this configuration file in =
the enterprise deployment archive. =] el S KB #ML Document
Copy the deployment descriptors tame _—
Py ploy P [Chclasses

Copy the descriptors web.xml and faces-
config.xml to WEB-INF of the SAP web project
(from C:\javapetstore-2.0-
ea5\build\web\WEB-INF to
C:\dev\petstore\WebContent \WEB-INF.

Note: You may want to add a HTTP proxy in the
web . xml if you want to get the RSS feeds displayed
in the application and your SAP Engine is behind a
firewall.

SAP COMMUNITY NETWORK
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persistence. xml
sun-web, xml
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

Import Java sources into the IDE (2% problems 52 44 Tasks} = Properties | 474 SErversW ¥ Data source Exp
e Copy the whole Java sources tree from 5 error.s, .139 warnings, 0 others (Filker matched 105 of 144 iterlns) |
C:\javapetstore-2.0-ea5\src\java to Desgpt":'” = Resource
C:\dev\petstore\src. B &9 Errors (Sitems)
@ Mo start tag (<divi), catalog. jsp
¢ Refresh the IDE project. @ Mo start tag { <Fiverbatim=), catalog.jsp
. . . 3 Mo start tag (<Fiviews). catalog.jsp
You vylll get errors in the JSP files due tp erroneous @ No start tag ( <html=), catalog. jsp
JS.P flles. This will prevent thg Web Project from @ No start tag (<tr). barner jsp
building, so you have to get rid of those errors first.

. . . =1ojx|
Fix HTML validation errors Befmer | vaidation .
The easiest way to proceed is to turn off HTML and Ezzzlur:::Path [# Enabls project specific settings Confiqure Workspace Settings. .,
JSP syntax validation in your Web Project. e path L ieendel e

H “ ” H ) Java Code Style The selected walidators will run when validation is perfarmed:
Go to the properties of the “petstore” project (context £ Java Conpler —_— e o] —
menu) and switch off: Java EE Module Dependencles Classpath Dependency Valdator
Javadot Location DTD Validator |
. { o
«  The HTML Syntax Validator S iy 5 oo
5P Fragment JavaScript Synkax Yaldation o
H Project Facets JLREE validat
e  The JSP Content Validator Froject References i ————— o
. Praject Yaldation 5P Cankent Validator O O [k
o The JSP SyntaX Validator gu”ﬂDEb“g Settings J5P Syntax Validator (] |
S ModuleCore Validator
?EW'T ZE:”T_ Wweb Services Walidation
9 TastRepastory WSDL valdaer ]
Task Ta;s 4 WS- Message Yalidator b
= Yaldation HML Schema taldator = =
eb Content Settings
meb Igru]tecttszttti;gi Enable All | Disable All
- ¥Daclet
4 | | ’l Restore Defaults Apply
7) Cancel
[%= Clean o ] [

Clean the web project petstore

After cleaning the project “petstore” the errors are
gone. Go to Project > Clean and select the project
“petstore”.

Step 6 — Deploy Petstore

SAP COMMUNITY NETWORK

Clean will discard all build problems and builk skates, The projects will be
rebuilt From scratch,

" Clean all projects {* Clgan projects selected below

=5 petstare
O = petstoreEar

Cancel

[ ]
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

Mark the Enterprise Application Project “petstoreEAR”
and from the main menu select Run - Run As - Run on
Server.

W Window  Help
Taggle Breakpaint Chr - Shift+E o J @ J )
Togale Line Breakpaint
Toggle Method Breakpoint
Togale Watchpaint
", Skip Al Breakpoinks

Remove &l Breakpoints

Restme
Suspend
Tetrminate
Step Inta
Step OvEer,
Step Return
R bo Line

T Use Step Filters

4 Run Chrl+F11
4, Debug Fi1

Shift+F5

Run Hiskory 3

I

Run Configurations. ..

Then select your default server ...

[22 Run On Server (=] 9]
Run On Server

Select which server to use

How do you want to select the server?
' Choose an existing server
= Manually define a new server

Select the server that you want o use:

|type filker bext

[l (= WDFNO02341624

... And then the application you want to deploy — in this
case “petstoreEAR”. Click “Finish” to start the deployment.

If this is your first deployment in a newly created IDE
process — which means, if you have just started your IDE
and have not performed any deployments yet — the IDE
will ask you for your credentials, i.e. the credentials of
the/an Engine’s administrator.

-
= Run On Server

Add and Remove Projects

Modify the projects that are configured on the server

Move projects to the right o configure them on the server

Avalable projects: Configured projects:

(5 petstoreEAR

add = |

You will get a notification of the successful deployment of
the application.

SAP COMMUNITY NETWORK

32 Deploy x|
Deploy finished successfly.
™ Don't shaw this dialog again
oK
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Migrating/Porting Petstore 2.0 to SAP NetWeaver Composition Environment

You will also see that the deployment archives L™ Project Explorer &2 = "i’b A
(petstore.war and petstoreEAR.ear) for the
projects have also been created under the defined folder
structure.

B {= webContent
& petstore. war

[#-B4, JavaScript Support

I':'I% petstoreEAR,

-"'—55' Deployment Descriptar: petstoreEAR
H-[Z EarContent

----- g petstoreEAR. ear

Step 7 — Test the Deployment and Fix the Issues

http://localhost:50000/petstore/faces/index.jsp is the entry URL of the migrated petstore application. One observes that
the entry page is populated with data initially fetched from the database. But by browsing the application one soon
notices that there are broken functionalities:

e The search function returns an empty data set, which results with a minimalistic page, even though there is no
error message on the page itself.

e The tag.jsp —which is the tag cloud of the application — throws an error, when trying to follow a tag link.
e The upload function behind the Seller function throws an error.
In the next section we will take a closer look at these issues and their resolution.

General Remark: Petstore manages application artifacts dynamically but in a very inflexible way. Take a look at the
utility class com.sun.javaee.blueprints.petstore.util.PetstoreConstants.java. Here is the relevant
code | want to drag your attention to:

package com.sun.javaee.blueprints.petstore.util;
public class PetstoreConstants {

public static final String PETSTORE INDEX DIRECTORY =
System.getProperty ("com.sun.aas.instanceRoot") + "/lib/petstore/searchindex";

public static final String PETSTORE IMAGE DIRECTORY =
System.getProperty ("com.sun.aas.instanceRoot") + "/lib/petstore";

Here you see that there is obviously a JVM system property “com. sun.aas.instanceRoot”, which the application
looks up at runtime and thus dynamically creates the path to the Lucene index and to the image directory (see the note
on Lucene in Step 5). These paths are then stored in the Java fields PETSTORE INDEX DIRECTORY and
PETSTORE IMAGE DIRECTORY respectively.

Note: This is in our opinion a bad application design and works against the Java EE programming paradigms. The
concept of Java based web applications foresees application folder structures like WEB-INF to handle such
requirements. Using a JVM system property is a rather bad choice in this case.
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The Search function issue Search Page
The function behind the Search Link of the upper Soarch swing || o Search Tage: @
navigation Subt | Reset

(http://localhost:50000/petstore/faces/search.jsp) returns

an empty result set. This is due to the fact that this — = _
search is not performed against the data base but | ” e ” Deserigtion " e " e |
against (Lucene) files stored on the file system. The path |

to those files is obtained as a Java System Property, et O A exanpl: 160 etnar e, arta Clara . 3305¢

which is unknown to the NetWeaver server at this point in Area o Mlegk e ]

time.

The Search function issue resolution #:? AS Java - Config Tool

File View Tools Help

S H |

= =¥ clyster-data

= E template - template_javaee

# X log configuration

+ P applications

+ E@Emanagers

+ a@sewices

+ A linstance - 1ID12752 MDFNO02341624)]
secure store

You would have to maintain the system property
com.sun.aas.instanceRoot for the JVM.

|
=

Open the NetWeaver Config Tool with the batch file
C:\usr\sap\LKG\J00\j2ee\configtool\
configtool.bat. The Config Tool will load the system
properties of your instance from the underlying system
database. Click on the instance ...

Servers | VM Environment | VM Parameters | Instance Profile

... and go to the tab “VM Parameters” and the sub tab VM Parameters
“System” as indicated in the screen shot on the right e
hand side. CustomValue |G |

Memory | System | Additional
Create the neW syStem property Calculmgdpammg‘“:arametewame WYalue Enabled
com.sun.aas. instanceROOt and Choose a Value for S::J\/I:l:\_:{TENS\DN_CDOMMMAND_HANDLER' E:n.m sap tools.memory.protoc ol ProtacolHandler %
it. In our case, we set this value to o iy ogq oo 5

. . awa.g e culily.p olic: . olicy ]

C:\usr\sap\petstore. Enable this setting and save avaxmancaggrg:;jg_hrwtnlglngnm:\t - oS30 6 mtcarver BT [

vz i ortableRemoted bjecttlass com sap engine systermn FortableRern otedbjectFroxy 2}
it. e ke geters s &

org. DH’\;CSR“EA ORBClass t:nl’r\ sap.engine. syste . ORBProxy Z
Note that you will be required to restart your system Tt e oeaton e onmoar st z
. . . . sun.lang.ClassLoader.allowArraySyniax ltrue 4]
in order for your setting to take effect. This is not S5 bl "~ ST TERTE] “
surprising, since we are dealing with a JVM system
property.

New | Remove | Disable.
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Now you would have to manually create this path and

File Edt view

Favorites  Tools  Help

add the search index files and the images folder to it. Qo - ) - (| D sewch |1 raers | | 50 X ) | [ | LF
e Create the folder structure Address |@ CYjavapetstore-2  0-saSbuild|we b WEB-TNFlib
. Folders X | | Mame = | Size
C:\usr\sap\petstore e = @)oo jr Toiren
. . ) N " Qcnmmons—fi\eunload—l.l.l‘jar 32KB
e The required (Lucene) search index is provided as gj;i & commons-o-1.2.jar 5 kB
zip file called petstoreIndexes.zip in the 2 Documerts and Settings g?mm°‘“5"°gg‘”g‘1'l‘]a’ S2KB
- . . . £ i jdom. jar 150 KE
Petstore 2.0 distribution. Extract the file g s Bhucene-core-2.0.0.jar 295 k8
C: \j avapetstore—2 . O_ ) IDE %petstore[ndexes‘zip 26 KB
. . T Z|rome-0.8 jar 193 KB
ea5\build\web\WEB-INF\1lib\ S 8] reme-etcher-0.7 4 21
petstoreIndexes.zipto 3 Intsl #]shale-remating jar KB
C:\usr\sap\petstore\lib\petstore B 3 javapetsiore-2.0-ea5
() bp-project
El 15 build
e Create the folder C:\usr\sap\petstore\ £ empty
lib\petstore\images = D web
I2) images
Note: The images folder is also used by the “Seller” 7 gﬂdz‘:;s
function to upload images as you want to define your oM
own pets to be sold on the online shop.
Now the search works! The screen shot at the right hand Search Page
side is the result of the search for “dogs”
Search Suing | [dogs Also Search Tags: ¥
Submit | Reset
Map
Name Description Tags Price
T (o e e e et e e o2 ™ | garageny 990

Center Point Address: I
For example: 4140 Network Circle, Santa Clara, C4, 95054

Area (n Miles): [30

Map Checked temis) |

The Tags issue

The pets are tagged with attributes in the petstore
application. So there is a many-to-many relationship
between the tags and the pets. In the database, the pets
are stored in the table “ITEM” and the tags in the table

Tag Page

excellent fun mferior  interesting

awesome @Ol

“TAG. sunset superi()r worthless
The Tag Page (Tag. jsp) is a so-called tag cloud
displaying all the tags available. A click on one of the
tags resolves this relationship. You can see the tag cloud
on the screen shot to the right hand side.
|

But the tag-item relationship is broken in the migrated
application. So a click on one of the tags in
http://localhost:50000/petstore/faces/tag.jsp throws an
error.

SAP COMMUNITY NETWORK

t watchinFlght Error:

'E An Exception has been encountered on the server side during an Ajax request server ogs for MLHET
[object Evror]
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Take a look in NetWeaver’'s main trace file by invoking
the Log Viewer, e.g.:

http://localhost:50000/nwa ->Problem Management
—>Logs and Traces - Log Viewer - Show View >
General > Default Trace.

There you will find something like this:

javax.persistence.PersistenceException:
relationship >>items<< of entity
{com.sun.javaee.blueprints.petstore.model.Ta
g(tagID=3) }cannot be loaded because the
entity is detached

or
javax.persistence.PersistenceException:
relationship >>tags<< of entity
{com.sun.javaee.blueprints.petstore.model.It

em(itemID=10) }cannot be loaded because the
entity is detached

The

The

Here you see the root cause of the problem: the

) SAP NetWeaver Administrator - Microsoft Interng

File Edit ‘Wiew Fawaorites Tools  Help

Qs -© - X &) &

/,.. ) Search ©

Address :éj http: fflocalbost: 50000 webdynprofresources)s

SAP Logs (Java)

Al Logs (Java)

Last 24 Hours (Java)
Alert (Java)

Log Viewaei

Default Trace (Java)

Shionw Wigwy Log |

Text Formatted Traces
General ]

Expert
Custom Yiew p | Log Archives (Java)
Recently Used View »| “hange Log

Standalone Log YViewer

persistent objects Item and Tag (along with their
relationships tags and items defined in the entities) are
detached at runtime.

External Log Files

The reason for this is the different implementation of
the so-called JPA fetch strategy in GlassFish vs. the
one in NetWeaver.

GlassFish implements this fetch strategy for many-to-
many entity relationships as “eager” opposed to
NetWeaver's “lazy” implementation. By the way, the JPA
spec foresees the “lazy” implementation.
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The Tags issue resolution

The resolution of the problem is adjusting the source
code of the persistence entities (Entity EJBS)
Item.java and Tag.java.

Add the property fetch = FetchType.EAGER to the
@Many-To-Many annotation in both files.

Save the changes, build the projects and redeploy
the application and thus verify the fix

In Tag.java:

@ManyToMany (fetch=FetchType.EAGER)

In Item. java:

@ManyToMany (mappedBy = "items",
fetch=FetchType.EAGER)

The Seller function issue

The Petstore application is an online shop for pets. It
allows for uploading data of a pet one wants to sell. This
functionality is provided on the “Seller” page, Follow the
instructions of the application in order to upload your
pet's and seller’s data. But even after providing all the
necessary information, you will find that this functionality
is broken.

The problem is again in the persistence layer of the
application.

Windows Internet Explorer x|

! } Persistence Failed : Please check if the server logs For more information!
.

The Seller function issue resolution

In this case the resolution is somewhat complex. On one
hand we have to

e adjust the error prone application’s source code
and

e on the other hand adjust the JPA configuration
(persistence.xml)

In the class
com.sun.javaee.blueprints.petstore.model.C

atalogFacade. java there is the method
addItem(Item item).The source code changes
required are high lightened in blue.

SAP COMMUNITY NETWORK

public String addItem(Item item) {

EntityManager em =
emf.createEntityManager () ;

try {
utx.begin() ;
em.joinTransaction () ;
Collection<Tag> mergedTags =
new Vector<Tag>() ;
for (Tag tag item.getTags()) {
tag.incrementRefCount () ;
tag.getItems () .add (item) ;
Tag mergedTag = em.merge (tag);
mergedTags.add (mergedTag) ;

}

item.setTags (mergedTags) ;

em.persist (item) ;

utx.commit () ;

// index item

if (bDebug)
System.out.println("\n***Item id of
new item is " + item.getItemID());

indexItem (new IndexDocument (item)) ;

} catch(Exception exe) {

try {
utx.rollback();
} catch (Exception e) {}

throw new RuntimeException ("Error

persisting item", exe);
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} finally {
em.close();

}

return item.getItemID() ;

Adjust the persistence.xml (SAP specific JPA
configuration). Add the property
"com.sap.jpa.execution.foreign-key-
handling" with the value = "topological”.

This is the file as it should look like (beyond the
comments). The relevant parts are high lightened.

<?xml version="1.0" encoding="UTF-8"?>

<persistence version="1.0"
xmlns="http://java.sun.com/xml/ns/persisten
ce"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema
-instance"
xsi:schemalocation="http://java.sun.com/xml
/ns/persistence
http://java.sun.com/xml/ns/persistence/pers

istence 1 0.xsd">
<persistence-unit name="PetstorePu">
<description>Petstore Persistence Unit
</description>

<jta-data-source>jdbc/PetstoreDB</jta-
data-source>
<non-jta-data-
source>jdbc/PetstoreDB</non-jta-data-
source>
<properties><property name =
"com.sap.jpa.execution. foreign-key-
handling" wvalue =
"topological"/></properties>
</persistence-unit>

</persistence>

Save the files, rebuild and redeploy the project.

This is the result of uploading a pet with a sunset. jpg
photo of it. The seller's name is “peter”. This verifies the
fix.

This concludes the migration.

SAP COMMUNITY NETWORK
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